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Overview 

Precision farming tools enable you to make sense of sets of geo-located 

data. 

 

You can create a coloured image of large sets of data (eg. Yield data) to 

make interpretation of the data easy or you can take a small dataset 

of 15 soil samples and image it just as well. In addition, you can label 

each point with up to 8 individual data value labels. You may want 

use this facility to display the soil test values for eight test items 

 

Many precision agriculture data sources (yield monitoring and spray 

and fertiliser rate controllers) are supported, as well as a generic 

comma delimited format which you can create in a variety of third 

party programs. 
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FarmStar  - vs - PAM PDP 

The precision farming features of both of these Fairport products are 

the same.  

In PAM PDP (Precision Data Processor) 

 There are links between your PAM data and the precision farming 

features. These links will become more powerful as the program 

develops.  

 You access the precision farming tools via the Precision Data menu 

option. 

 The lists of farms, paddocks, nutrients, consumables and crops are 

used to populate pick lists when using the precision farming tools. 

In FarmStar   

 

 You access the precision farming facilities from the File, Show and 

Tools menus. 

 You establish the lists of consumables and nutrients as you use 

the program. 

Mapping Terms  

Mapping concepts and jargon can be difficult to understand. With the 

proliferation of GPS units, Google Earth, Google Maps and the like, 

these concepts are becoming more familiar to us. If you would like to 

read a brief description of these concepts, please refer to page 41. 

 

Visualizing Your  Data  -  Some Background Information 

If you would like to read a brief description of these concepts, please 

go to page 43. 
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The PDP Screen Layout 
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Getting your data into PDP  

File Requirements 

The very minimum that a file needs in order to load it into the system 

is two fields describing the geo-location of each point. That is, either a 

Northing or an Easting, or a Longitude and a Latitude. The visualising 

tools for display can interpret any additional columns of data. All geo-

located data files will contain at least an easting and a northing and 

usually an altitude.   Specialised files such as yield data files contain 

other data values such as Area, Mass, Moisture, Yield, LoadID and 

more. 

 

If you are generating your own files then we suggest you use a comma 

delimited format, and ensure that the first line of the file contains the 

field names of each column.   The program will recognise the field 

names “Northing”, “Easting”, “North”, “East’, “Longitude”, ”Latitude”, 

“Long”, ”Lat” as meaning that the column contains real world 

coordinates. 

The Data Manager – “All Precision Data Sets” 

Your precision data is imported into PDP and the dataset is registered 

(meaning – the location of the data is saved to the database and a 

folder is created inside the main folder called “Precision Data” (which 

in turn, lives inside your main program folder (PAM or FarmStar).  

You have to let the program know where your data is, and what 

format it is in.   

 

From the File menu in FarmStar, choose Precision Data Processor. 

 

In PAM choose Precision Data Processor from the Precision Maps 

menu.   

Getting your data from a data card or a folder or removable 

drive 

Yield data and other datasets are often brought in from your harvester 

or tractor on a memory card. These cards, when inserted into the card 

slot on your computer, behave just like a removable disk. That is, you 
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can access the file(s) on the card through Windows Explorer by 

clicking on the card’s “Drive” …  

However, PDP can read the data directly from your card. It can also 

read your data from a folder on your 

computer’s hard disk, or from a 

removable drive (e.g. a USB drive) 

The steps are the same either way:  

Click on the “Import” button  

Choose the Data Type that you are 

importing. 

 

 

Having chosen the data type, click on the Open Card or Folder button. 

Navigate to the folder or card (or removable drive) where you data is 

located. In the screen shot below, I have clicked on the Removable 

Drive (F:) 

 

 

Please Note: For tips on dealing with many of the file types imported 

by PDP, please refer to page 58. 
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PDP now displays the contents of the selected location on the right 

hand side of the window... What PDP displays depends on the type of 

data you are importing and the type of on board device that may have 

created the data. 

 You may want import all the data or just some of it. PDP has buttons 

to assist you in making your selection. The datasets that PDP will 

attempt to import will be those that have a tick in the “Select” column. 

In my example above, I have chosen to import 4 datasets and leave 4. 

Having made your choices, click Next to proceed to the “Data 

Matching” window. 

 

PDP will attempt to match the incoming datasets to your 

paddock list.  The Data Matching windows enables you to associate 

the incoming datasets with your paddocks. If you choose the “<Create 

New>” option on the paddock pick list, PDP will create a new farm and 
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paddock for you (based on the farm and paddock name in the 

incoming data - if they exist) that you may rename later. 

 

When you’re done with Data 

Matching, click the Import 

button to begin the 

importing process.  

 

The screen shown here will 

display the progress of the 

import process. If you are 

importing a very small data 

set, you may not even get to 

see this progress screen. If 

on the other hand you are importing a lot of yield data, you will 

definitely see it.  

 

On completion of importing, PDP will display the datasets in the “All 

Precision Datasets” list. 

Tips on Importing Files  

There is a huge range of data file types that people need to import. 

Unfortunately some manufacturers often change the file format of 

their files without notifying us. This causes error messages to appear 

in PDP. Please notify us of any file types you are having trouble 

importing and if possible send us a sample.  

For tips on dealing with many of the file types imported by PDP, 

please refer to page 58. 

 

If possible it is best to import yield data directly from the card or make 

a complete copy of the card into a folder on your computer (including 

ALL subfolders) and import from there. 

Selecting a Data Set for Analysis 

Clicking on the “All Precision Data 

Sets” button, you will see the list of 

datasets that you have imported, 

organised into a “tree” and sorted by 

Farm, Paddock and Year.   
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. 

If you Right Click on a data set on 

the “tree”, set you will get an options 

menu. 

You can 

the select 

the data 

set to 

work with by double clicking on the 

list or by selecting Load Dataset on 

the menu. It will then bring up a 

window (see below) to allow you to 

select which data field (heading) you 

want to use for your analysis.  

 

 

 

Choose the data column (“Z Value”) that you want to work within the 

precision Data Desktop. This will be a Yield column if you are 

importing yield data.  

 

This data will then show as a new item on the Precision Data 

Desktop List 
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Precision Data Desktop  

Items in this list are the data 

sets that you’ve chosen from 

the “All Precision Data Sets” list 

or layers of images, contours 

etc which have been generated.  

That is, it includes Images (that 

have just been created or those 

re-loaded from the “All Precision 

Images” list) loaded Datasets, 

Range Boundaries (Contours 

just created) and Circles. 

 

Also, if you have created or selected a polygon to be used in your data 

processing and analysis, you will also see a layer called “Constraint 

Polygon” on this list. For more information see pages 28 - 30. 

 

Precision Data Desktop – Right Click Menu 

If you right click on an item (a layer of data or an image, or a layer of 

circles or a layer of contours or the Constraint polygon layer) you will 

get an options menu.  

The number of menu options that you will see depends on the item 

type you’ve selected. All items have the options: 

 Visible  - (Hide / Show layer) 

 Remove – (Remove layer from the list) 

 Zoom To – (Make the layer fill the map view window) 

 Print – to print an image, or the raw data layer (this 

option will only appear when you have selected a map 

that PDP can print) 
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If you’ve selected a 

Data Set you will see 

the additional 

options on your 

Right Mouse menu:  

Processing  Over 

Years and Generate 

Swath Samples.  

 

Processing  Over 

Years : This enables 

you to select one or 

more additional 

years to process for 

the purpose of creating a Maximum, Minimum or Average image.  

See Page 57 for more information. 

Generate Swath Samples: to create a layer of polygons that represent 

the path of the machine used when the data was collected. See Page 

20  for more information.  

 

  

  

 

Removing a layer / Hiding a layer 

By Right Mouse clicking on any of the 

layers in the Precision Data Desktop, 

you can choose “Remove” to delete that 

layer from the screen. You may want to just hide the layer. In this 

case, click on the light globe icon to turn off the layer 

 

Zoom to   

To zoom into the area that the data occupies, right click on the data 

layer and choose “Zoom To” from the menu.   
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Working with Data Sets in the Precision Data 
Desktop  

Imaging 

Overview 

Imaging is by far the most powerful function, and there are many 

options available to ensure that you can generate the most accurate 

representation of your data. A good understanding of these options 

will ensure that you don’t make mistakes and potentially misinterpret 

your data.  

 

Image Toolbar 

This is used for processing data to create Images 

1. The “Generate Image” button 

2. The “Save Image” button – images can be saved and reviewed 

later via the “All Precision Images” list. Images can also be used 

in some VRT projects (depending on the on board device type) 

3. Settings. Click this button make changes to the default settings. 

There are image generation settings that can be “tweaked” and 

also naming conventions for saved images.   

4. Solid (an image with discreet or solid colour areas will be created) 

or Blended (an image with blended colours will be created) 

Images options.  

5. Smoothing options. Data can be quite “noisy” – you may want to 

smooth out the noise in your data. Try experimenting with these 

button to get a feel for their effect on the images being created. 

6. PDP has 3 “Interpolation” methods.  ”*” Fairport Optimised,  

”I”  Inverse Distance,  ”K” Kriging. If you are in any doubt 

about which you should use, always choose  ”*” Fairport 

Optimised 
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7. The Advanced Image Analyzer which can be used to create 

derived images from one or more images and by applying 

calculations. For example, you can quickly create a nutrient 

depletion image from a yield image. See page 49. 

 

To go directly to the steps for creating a Yield Image, go to page 19. 

 

For a “crash course” on the technology behind imaging, please refer to 

page 45.  

 

For information on using the Advanced Image Analyzer, please refer to 

page 49. 

 

When you have created an image and you have it selected on the 

Precision Data Desktop list... 

 

 

 

 

... you will notice 2 buttons appear in the data range setting area 

(bottom right of the screen)... 

 

Linear – vs – Equalized images 

 

To learn about these options and what they can do for you, please 

refer to page 54. 

 

Pixel Size 

Pixel size effects the speed to generate your image, and resolution of 

the image.   It can be adjusted through the “Settings” 

button on the Image tab. 
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If you increase the pixel’s size up to 10 metres a pixel, you may get a 

very “blocky” image, however, this also substantially reduces the 

amount of time required to process the data. 

 

The best advice for pixel size is to experiment. Sometimes, it’s handy 

to choose a fairly large pixel size to generate a quick view of your data.  

As you adjust various parameters, you can reduce the pixel size to 

generate a more finely detailed image. 

 

Naming Conventions for Saved Images 

It is worthwhile becoming familiar with the image naming convention 

settings.  The way you choose to name your images can be adjusted 

by clicking on the “Settings” button on the Image tab. 

 

On the form that pops up, click on the “Naming Convention” tab. 

 

Below is an example of how the image name would look if we choose 

every option.  
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Circles 

The Cicles Tab 

 

This is used for processing data to create Circles 

 

1. The “Generate Circles” button 

2. Optionally choose to display your circles filled with colour or 

with coloured circumferences only.  

3. Size Settings. Chose the size of the circles.   

4. Size your circles based on the values of a chosen data 

column.  

5. Select the data column to be used to size your circles (this list 

becomes available if you chose to size your circles by the 

values in a data column). 

 

Circle Colour 

For each circle generated for each point, it is coloured according to the 

original field you chose. It is coloured according to your clip range and 

palette. 

Circle Size 

For just knowing where your data is, choosing Small circles, and 

choosing the ‘Filled’ option is a quick technique. If you want to have 

the circle sizes represent the changing values of another data field, 

choose “Size by selected field value”… choose the data field from the 

pick list. The larger the data value, the larger the circle size will be. 

 

For more information on visualizing your data using circles, go to page 

26. 
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Contours 

Contouring Toolbar 

This is used for processing data from the current Image to create 

Management Zones. 

 

1. The “Generate Contours” button 

2. The “Save Contours” button – contours can be saved and 

reviewed later via your farm mapping layers. Contours can 

also be used in some VRT projects (depending on the onboard 

device type) 

3. Transparency slider. Use this to view through the contour 

polygons to an image below.   

4. Polygon boundaries can be hidden or displayed.  

 

Note : The image should have minimal colours and detail for this to 

work. If it cannot create the contours try reducing the number of 

colours in the image or make the image smoother. 

Data Set Tools Toolbar 

 

There are three main purposes for the buttons on this toolbar.  

1. To select or draw a polygon to limit the area of a generated 

image (“Image Constraint Polygon” ... See Page 28) 

2. To sub-set data. Using a selected or drawn polygon, you then 

choose to exclude data from inside or outside the polygon – 

then save the remaining data to your Precision Data Set list. 

This can be useful when yield data is collected over more 

than one paddock accidentally.  
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3. To view data statistics for a selected or drawn polygon. 

 

 

Button to select a polygon from your farm mapping layers  

 

Button to commence drawing a polygon 

 

Button to commence drawing a hole in your drawn polygon 

 

Edit Button – remove, add or move points on a polygon 

boundary 

 

Undo Button – Undo your drawing actions  

 

Panning Tool – Your mouse cursor becomes a panning or 

dragging tool to move your image or data display around the 

screen 

 

Selection Tool – Use this tool if you have finished using your 

polygon and need to delete it. Select polygon, then press Del, 

or right click for the menu 

 

Display Data Statistics – click on this button to display a 

spreadsheet of data statistics for the data inside your drawn 

or selected polygon 

 

Data Subset tool – Exclude the data outside the polygon 

 

Data Subset tool – Exclude the data inside the polygon 

 

Data Subset tool – Revert back to including the entire data 

set. (Switches off the data exclusion modes) 

 

Data Subset tool – Save the remaining data to a new data 

set. 

 

For a full explanation of how to use the drawing tools, see page 47.  
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Creating a “Swath Polygon” layer 

Most data that is imported into PDP has been derived from an on 

board device that has logged data from a machine which has a swath 

width. To see the display of the machine’s swath follow these steps:  

 

1. Select a Dataset on the Precision Data Desktop and then click 

on the “Swath Polygons” tab to display the options  

 

 

 

2. Set the appropriate options for the swath layer. The “Merging” 

options are provided due to the fact that sometimes there is a 

vast number of data points in a dataset. The “Do not merge” 

option will result in one polygon for each data point. “Merge 

samples by ten” will combine 10 data points into one polygon. 

The “Auto-Merge” option will result in long polygons where your 

machine has been traveling in a straight line. That is, this 

option will create the least polygons to represent the job.  

 

3. GPS Offset – If the GPS is not mounted centrally on the 

machine, the swath will appear offset. Use  

 

4. To flood-fill the polygons using the data values of the dataset in 

use, choose that option, otherwise you can choose to leave the 

polygons unfilled, or filled with a color of your choosing.   

 

5. To save the layer of polygons to an ESRI SHP (Shape) file click 

on the Save button. You will need to have the Swatch Polygon 

layer selected in the “tree” first.  
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Working with Yield Data 

Getting your data from a card 

See Page 5. 

Steps to import your yield data 

Follow the steps outlined for you in the topic “Getting your data into 

PDP” on Page 7. 

Steps to create a yield image 

When you have a dataset loaded & have clicked on the Image Tab, 

create an image using the following steps: 

Choose the range of data and colouring 

that you would like use for the image. 

Data ranges and colours can be saved 

and re-used. Choosing a previously 

saved palette will instantly set up your 

ranges.  In the image at left, I have 

chosen my palette “Yield (T/Ha)”.  

You can click on “Auto-Fit to Data” and 

PDP will set up the minimum and 

maximum for you to match the data.  

You can manually specify the Min & Max value to trim the data. This 

is to remove zero or false low readings and inaccurate high readings. 

To set the number of colours used in the range selected, set the 

Number of Intervals or the Step value, the coloured circles displaying 

the raw data (in the centre of the screen) will change automatically. 

 

You can edit the colours manually by 

clicking in the coloured box in the table. 

The colour chooser will pop up. 

You can save and name these palette 

settings by clicking on the “Save” button 

at the bottom. These can be re-used at 

anytime by picking from the pick list. 

 

Palettes can also be exchanged with other uses. To exchange saved 

palettes, use the “Export” and “Import” buttons 
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Choose for the type of colour range change. (Solid or  

Blended colour changes) 

 

Choose for the amount of detail in the image. (Smoother 

for VRT use) 

 

 

Choose the interpolation method.  Leave on Optimised if 

unsure.  See Page 45 for more information.  

 

You are now ready to generate the data image… click the  

“Generate” button.  

 

 

If you are satisfied with the image, click “Save” and name the 

image for future reference. You may choose to save the image file 

into a special folder that you have made for the purpose. If you let 

PDP manage your images, it will. The “All Precision Images” image 

manager will list all images created and saved using the precision 

farming tools. To display the Image Manager, click on the “All 

Precision Images” button  

 

 

If you want to abandon the image you created and create 

another with different settings, simply click on the  “Generate” 

button again   

Imaging Tips and Options  

Unrealistic High Values 

Sometimes your yield data can have some unrealistic, very high 

values in it. Usually there will be an insignificant number of these 

unrealistic values and they can be excluded. You are advised to reset 
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the range of the data under these circumstances as the image colour 

range can be effected by stray high data values. You should also 

exclude any unrealistic low values.  

 

Unrealistic Low Values 

Sometimes it may be difficult to ensure that the harvesting machine 

is always totally in the crop and harvesting a full swath. On such 

occasions the yield monitor may record unrealistic low values for an 

area. By excluding these low values, you avoid displaying these 

unrealistic low yielding areas. For example, if you know that the crop 

did not yield below 0.5 Tonnes per Hectare at any point, then use this 

value (or an even higher value) as your minimum.   

 

PDP will display an “X” on the raw data set view of the data where 

you have excluded values. This will indicate to you that you might 

have excluded genuine values. See the screen shot below. I have 

excluded genuine values from my yield map by setting my minimum 

too low. 

 

 

 Tip: Once you become familiar with the normal range of your 

yield data, it is a good idea to save a “Palette” for each crop 

type. This will enable you to select these pre-set parameters 
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from the Palette pick list. 

 

To change the size of the yield map and the way that the program 

searches for data click on the “Settings” button. 

  

Please Note: Setting the search radius to less than the swath 

width will result in gaps in your yield image. Setting a large 

search radius will slow down the imaging process and could 

result in ‘over smoothing’ the data.   

 

Tip: If you have two harvesters working in the one paddock and 

only one is equipped with a yield monitor and they are 

harvesting alternate swaths, set your search radius to slightly 

more than two times the swath width. This will make the yield 

image fill in the gap… the missing data will be “interpolated”. 

 

Changing the pixel size will have two effects… The smaller the pixel 

size, the larger (in Kilobytes) the image will be and the smoother the 

image will be.  

 

Tip: If you want to create an image very quickly, select a large 

pixel size (eg. 10 metres) and use a small search radius (just 

over or exactly the swath width. 

 

What can you do with a yield image? 

Now that you have a yield image on your screen you can do the 

following: 

 

 Move your mouse around on it to see the yield value at any point. 

The result is displayed on the Status Bar at the bottom of the PDP 

screen. 

 

 Use the Contouring tab to create a set of contour polygons which 

can be saved to your farm mapping layers and also used for 

variable rate projects. 

 

 Using the Dataset Tools tab, choose the polygon drawing tools, 

draw polygons around areas of interest to measure the area and to 

display a statistical analysis of the yield data (and any other data 
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that is included with the yield … eg. Moisture, Height) within the 

drawn polygon. 

 

 Using the Dataset Tools tab, extract sub sets of the data by 

drawing polygons around the areas you want to include in, or 

exclude from the data. Again, perhaps you could create a layer 

called “Temp” for these purposes. You can always delete the layer 

before closing down the program. This can be useful for both 

research purposes and to resolve a situation where you have 

collected data from more than one area (paddock or field) by 

mistake. The data can be separated into two or discreet new data 

sets.   

 

 Use the “Advanced Image Analyzer” to perform calculations on the 

underlying data and to generate derived images. See page 49. 
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Using circles to plot data 

Circles are useful for plotting data that doesn’t have sufficient data for  

a good image plot, or for overlaying more information on an image.   

Circle plots are also excellent for soil test results.    

 

After you have loaded some data, select the “Circles” tab.     

For information on each of the options on the Circles tab, go to page 

44. 

  

The sizing options are easily selectable via the option buttons.  

   

 Small, Medium, Large will give all circles a constant size. This 

can be useful when you are representing soil test results by 

coloured circles as shown here. This is a map of Phosphorus 

values for soil samples taken 100 m. Apart (1 sample per 

Hectare) 
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  Size by selected field value. Choose this option when you 

want to show the value of a field using the circle size. In the 

example below we are still showing the circles coloured by 

Phosphorus, but we are also showing them sized relative to the 

Organic Carbon (%) values ... 
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Image Constraint Polygons 

A side effect of the image creation process is that the search radius 

you opt for will cause the image size to sometimes extend beyond the 

area where the data was collected… For example, it is possible for a 

yield image to extend outside the boundary fence of the paddock.  

 

To ensure your image remains within the boundaries of the area being 

analysed you can use an image constraint polygon. The polygon can 

be a pre-existing polygon (eg. a paddock boundary) or you can opt to 

draw an appropriate polygon for the purpose. Either way, the steps to 

constrain your image to within the area of a polygon are these: 

 

1. Either draw a new polygon or select an existing one from your farm 

mapping layers. See the Dataset Toolbar options here on Page 18. 

2.  The current “Constraint Polygon” will be displayed or hidden by 

means of the ‘light globe’ on the Precision Data Desktop list.  

3. When you generate a new image using the Image Toolbar as per 

normal, to make use of the image constraint polygon, be sure to 

tick the check box: “Use Polygon to Constrain Image”  
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In the screen shot above you can see that we have drawn a polygon 

around a section of the data. We will now create an image using our 

constraint polygon... 

 

 

 

Subset Data 

The subset data option can be useful for two reasons. Firstly, if you 

have collected data from two or more discreet areas in the one dataset, 

you will most likely want to separate those discreet areas into discreet 

datasets.  

Secondly, you may from time to time want to extract from a large 

dataset the data from a discreet area within the larger area for further 

analysis.  

 

For either of these purposes the steps you must take for achieving the 

desired result are these: 
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Display the whole dataset using one of the normal methods of 

visualising your data (Image, Path, Circles) … Let’s use an image for 

our example. 

Using your normal Drawing Tools, draw a polygon using the tools on 

the Datasets tool bar (See Page 18). Draw the polygon to include the 

area on the image that you want to extract (that is, draw the polygon 

to enclose the data sub set that you want to remove) or… Draw the 

polygon to exclude an area. 

  

Now choose Discard points inside the selected polygon or Discard 

points outside the selected polygon as appropriate using the buttons 

on the tool bar. 

Save the resulting dataset by clicking on the Save button. 

The Save DataSet As ... form looks like this... 

 

 

Data Statistics 

The data that you load into PDP can be analysed to determine 

averages and other statistics. Sometimes you may want to know the 

statistics of a subset of the entire dataset.  

Display the whole dataset using one of the normal methods of 

visualising your data … Let’s use an image for our example. 

 

The simplest way to achieve this is to: 

Draw a polygon that encloses your area of interest on the image. 
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Click on the Data Statistics button on the Data Sets toolbar (See Page 

18) to display the data statistics. 
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Merging Two Data Sets 

 

The way you record data on your farm (in particular Yield data at 

harvest time) may not suit the Farm/paddock/Season/Date hierarchy 

system that we have provided you in PDP.  So, when you initially 

register your data it may not be the way you actually want your data 

structured. 

Apart from the Data Subset options that enable you to exclude data 

subsets from a big dataset, we have provided you with the facility to 

merge two datasets together 

 

This could also be used in situations where you have two harvesters 

working in one paddock. 
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Let’s say you have two datasets. One contains some of the yield data 

from Paddock A (the top Paddock) … the other contains all the yield 

data from Paddock B (the bottom paddock) but also some from 

Paddock A! 

What we’ll need to do is: 

Select Merge Datasets ... from the Tools menu. 

The form displayed above will appear. 

Starting with Data Set 1... 

Click on the button to display the PDP Datasets list. 

Choose the first data set (click “OK”)  

 

Repeat the steps to select Data Set 2 

The screen will now look like this: 
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PDP will nominate a default name of the output dataset. It will use the 

first data set. In this case Paddock A, however, as you click “OK” to 

perform the merge, PDP provides a “Save As...” form.  

 

Next we must make sure that we are merging data of the same type. 

Check the “Column Matching” section. 

 

 

 

 

 

Click on the “OK” button to perform the merge, next choose an 

appropriate name for the merged dataset on the “Save As...” form ... 

then click “OK” 

 

Now PDP will list you newly created data set on the “All Precision Data 

Sets” list.  

 

The next part of this task is to  

a) Load the data into the Precision Data Desktop 

b) Use the Data Set Tools tab. Draw a polygon around Paddock 

A’s area and...  

c) Using the Subset Data tools, exclude all the Paddock B data.  
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d) Save the Paddock A data. 

e) Using the other Subset Data option, exclude the Paddock A 

data 

f) Save the Paddock B data.  

  

Variable Rate Control Output 

 

PDP produces variable rate application recipe files using both 

Polygons and Images as its source. Some controllers can only work 

with polygons as the map source. For those controllers you are bound 

to use polygons as your starting point, for all others you can choose to 

use either an image or a set of polygons as your starting point. If you 

are using a layer of polygons, ensure you colour the polygons 

differently in line with the rates you will be using for each polygon 

(management zone).  

Using a Polygon or Region map for your VRT 
project  

If you are using the region or polygon method to define the rate areas, 

you must first draw the areas and use fill colours to define the 

discreet rate areas. 

Each bin or tank or applicant (seed, fertiliser or chemical) will have its 

own discreet layer.  

I have drawn these 

three discreet areas 

using the Mapping 

drawing tools on a 

new layer I created 

called  

“VRT – Urea – PU05 

– 2014”  

See the farm 

mapping manual for 
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information on drawing objects and layer creation. 

Using PDP’s contouring facilities, it is a very quick and simple job to 

create a layer of polygons from an image (yield, nutrients removed etc) 

See Page 18. 

Using an image for your VRT project  

If you are using a Bitmap as your method to define the rate areas, you 

must first ensure that you have generated the image in PDP. 

 

Using images VRT that are not generated by PDP 

If you would like to use an image from another source (e.g. a NDVI 

satellite image) you are advised to do the following: 

1. Import that image into your PAM Mapping or FarmStar Lite 

mapping layers. 

2. Using the drawing tools, draw management zone polygons over 

the top of the image, filling those polygons with colours – ensure 

that you use the same fill colour for each area that share the 

same application rates. 

3. When creating the VRT Project in PDP, use that drawn layer 
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Creating the VRT Project   

 

Start here: 

 

1. Click on “New” button.   

2. Enter in the project name 

3. Select the Farm/Paddock/Season 

4. Choose the variable rate controller... 
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5. Select the “Prescription Map” ... Either a polygon layer 

 

 

Or an Image ...  (I am choosing this image [below])  

 

 

Then click OK... 
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6. Having chosen the initial presciption map, click OK to save the 

project. 

7. Now to choose the 

consumable for Bin 1 and 

rates... 
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8. If you are using more than 1 

bin, click on the “Add” label 

on the next “tab” after Bin 1 

 

 

 

9. For Bin 2 ...  I selected Mace Wheat as my cobsumable and I 

chose a different prescription map layer (I used another image   

“1999 P”) ... I did that by clicking on this button found below 

the section of the screen where you enter the rates... 

 

Then simply enter the rates for each colour ... as I did for Bin 1.  

To add more bins, follow the same process. You can choose a 

different prescription map for each bin if you want to.   

10. When the VRT Project is completed, or at any stage you 

can “Save” the project. You can always return to this project 

and add more bins, alter rates .. whatever.  
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You can also choose “Save As” and save the project under a 

different name, then edit the project (add more bins, remove 

bins, change rates, choose different prescription maps .. 

whatever).  

 

 

11. When you are ready to export the vrt recipe to a 

controller, click on “Upload” ... then  

1. Select the Projects to upload to the controller 

2. Choose the destination (usually the Card or USB device) 

3. Click OK.  

 

That’s it. 
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Mapping Concepts 

Coordinate Systems 

In PDP we use the two most popular coordinate systems. Two things 

to understand here. One is the Datum, and the other is the Projection. 

Datum 

Datum describes the coordinate system that data is stored in. Over 

the years, there have been many datum’s to describe the location of a 

single point. There are many systems because the world is not a 

perfect sphere, and the various representations have been invented to 

afford better accuracy within local regions, and also updated with 

technological advances. In PDP, WGS84 is the Datum used to store all 

coordinates. 

 

If you’ve ever used a GPS (Global Positioning System) these are the 

coordinates that they use. It’s a system where a position North to 

South is called Latitude and is in the range of –90 (South Pole) to +90 

(North Pole). East to West is called Longitude and is in the range –180 

to 180, Locations to the West are negative, to the East are positive. A 

coordinate of this type is made of up degrees, minutes and seconds.   

i.e. 13 degrees, 45 minutes, 34 seconds. The physical distance 

between 1 degree of longitude varies depending on how far you are 

from the equator, with the widest point being the equator, and the 

shortest point being the north and south poles when all longitudes 

meet. 

Projection 

Projection defines the way that coordinates are displayed on a flat 

surface. Because the world is a sphere, north south lines (longitudes) 

may be bent or straight depending on where you are (as a view) when 

you view them. A man called Mercator developed a system called 

isotropic to ensure a view of an area of the earth’s surface. That is, it 

takes longitudes and latitudes and transforms them so that it displays 

your map in a square grid. Visually, a metre east to west is visually 

the same size as a metre north to south. 
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The Mercator system was devised to enable more efficient mapping on 

a flat surface and is excellent for doing localised work, rather than on 

a continent scale. Mercator coordinates work by taking 6 degree 

vertical strips of earth and assigning each one a Zone number. A point 

on the earth’s surface can be referenced by a Zone number and then 

the number of metres east west (called Easting) and metres north 

south (called Northing). A Zone is about 800,000 metres (800km) wide 

and slightly overlaps each other at the edges. The westmost coordinate 

of a zone starts at about 200,000 metres and measures to an 

eastmost coordinate of around 800,000 metres. At this point the next 

zone begins at around 200,000 metres again. 

 

There are many interpretations of the Mercator grid, all are very 

similar and  PDP uses the Australian Map Grid, formalised in 1984, 

and called AMG84 and the Map Grid of Australia (MGA 1994) which is 

the Universal Transverse Mercator projection of the GDA94 

latitudes and longitudes. The GDA94 longitudes and latitude co-

ordinates are extremely close (within a metre) to the WGS84 (the 

system used in GPS units).  

 

PDP stores all mapping vector data in WGS84, and translates into 

AMG84 or MGA94 for drawing, depending on the task on hand. 

 

When doing any precision mapping tasks, PDP handles all the source 

data in MGA94, which provides for faster and accurate imaging. 

 

 

Visualising your Data 

Data Fields 

Data Fields, in PDP terms, are the names of columns of data, not 

paddocks!   A soil sample file may contain Fields  “Easting”, 

“Northing”, “Altitude”, “pH”, “N”, “P” and “K”. 

 

Overview 

PDP provides the following methods for representing your data.  You 

decide the methods to use depending on what you want to achieve… 
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trial and error will be needed to guide your choices. Following are 

some suggestions: 

Palettes 

Precision mapping is all about representing data visually so you can 

interpret it. Colour plays a big role in this. For example, using dark 

colours for low values, and bright colours to represent high values.   

In a grey scale from white to black for low to high, or, if you prefer, 

from black to white for low to high. PDP provides the facility to make 

custom palettes. 

Raw Data 

When PDP first loads a dataset, it will always display your data in its 

raw form. The data is represented by coloured circles of a consistent 

size. A histogram of the data is displayed. This is your starting point 

from which you can create more sophisticated views of the data.  

Circles 

Circles are handy for getting a visual impression of the geographical 

layout of your dataset, and also for colour and simple representation.   

PDP will generate a circle for each point in your dataset. 

 

Generally appropriate for small to medium size datasets. Coloured 

circles are useful to display soil test results. A layer of circles can be 

displayed over an image of yield. Circles can be created with the size 

of the circles determined by the values of the data.  

Images 

Using sophisticated algorithms, images can fill in the missing values 

between data points… a process called interpolation making them 

suitable for most datasets.    

 

By using the settings available to you in creating an image, this can 

be the quickest way to see where your data is located. See the topic on 

Pixel Size on Page 15. We mentioned above that circles could be used 

for this purpose also.   
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Contours 

Having created an image, you can then create a contour map from 

that image. The contours are created using polygons that can be 

subsequently used in your general farm mapping area and as recipe 

maps for variable rate applications.   

 

Items common to all visual tools 

Where does the output go? 

When you generate visual results from your data, such as circles and 

images, they are displayed as “layers” on the Precision Data Desktop. 

These layers can be removed and hidden at any time.  

 All layers in the Precision Data Desktop are not saved with your 

normal farm mapping data, and are discarded when PDP is closed.   

A separate layer is generated for each output type.   Objects on these 

layers cannot be edited.    

Images and contours can be saved and those saved objects (or layers) 

are made available for you to view in the general farm mapping area. 

 

 

“Crash Course” on how imaging works  

A crash course on how “Imaging” works using soil sampling as an 

example. 

 

For the steps to create an image from yield data go to Page Error! 

Bookmark not defined. 

 

Imagine an area that is 500 metres square. Let’s say we divide this up 

into a grid where each grid cell is 5 meters square. That would give us 

100 cells x 100 cells. Let’s also say that we have a pH value taken 

every 50 metres. That would mean we have a pH value for every 10th 

cell vertically and horizontally. What we now want to do is generate 

what we think the values in all the other cells should be (that is 

interpolation). 
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One of the most important factors is the search radius. You can find 

this parameter on the “Data Processing Options” form, which you 

access by clicking on the “Settings” button on the Image tab 

 

 

... and it’s used as follows: 

 

Let say we start at the first cell of our 100x100 cell grid. We look in all 

cells around us that are within the search radius distance. If any of 

these cells contain a pH value (remember one every 10th cell, which is 

one every 50 metres), then we add that value to this cells value, but 

scale the value according to how far away it is from the known value.   

The further away it is, the less it’s ‘value’. This process is repeated for 

every cell in our grid. 

 

You might guess that the bigger the search radius, the more ‘known’ 

cells will be included when considering each ‘unknown’ cell. If it’s too 

small, then your image will contain holes, if it’s too large, then you 

whole image may wash out to one colour due to it including just about 

every value when computing each unknown cell. 

 

Generally the program will calculate a fairly reasonable search radius 

for you, but you may want to override this if your dataset is an odd 

shape, or you are getting holes, or not enough detail. Sometimes, only 

you, with the insight of your data can make these decisions. 

 

You can also adjust how much each value is scaled. 

These are on the Image Tab and are ‘Detailed’, ‘Smooth’ 

and ‘Smoother’.  

 

 

 Detailed means that the further away a cell is from the known cell, 

the less affect the known cell has on unknown cells. 

 Smooth is similar to detailed, but each known cell has more effect. 

 Smoother means that distance between the known and unknown 

cell does not diminish the value at all. 
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Drawing Tools Explained 

In PDP you will find a set of drawing tools to enable you to draw 

polygons. Polygons are used for three purposes in PDP. See pages 28 

to 30 for details. 

 

 
Button to commence drawing a polygon 

Click on this button to put your mouse into polygon drawing mode. 

 

Then … 

 

1. Left Click in 

the Map View window to 

start drawing your 

polygon. 

2. Click on the 

next corner/point... 

3. Click on the 

next corner/point... 

4. Continue 

until you need to end the 

process, then 

5. Right Click to 

Close the polygon. 

 

 

 
Edit Button   

 

Click on this button to put your mouse into polygon editing mode. 

For example, I want to move the points I drew above to make the 

polygon fit tightly around the data boundaries… 

I click on this tool button then 

Click inside the polygon to display the “Drag Handles”  

… now we’re ready to begin moving the points (Drag handles) into 

their correct positions…  
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 To Move a point:  

When the mouse gets near a  

drag handle (point), the black drag 

handle turns into a small empty black 

square. 

This means it is "ready" to be moved. 

Hold down the left mouse button 

and drag the point to the correct position 

 

 To Add a new point along the boundary, 

move the mouse to the position and you 

will notice a small empty black circle will 

appear. When you are satisfied with the 

position, left click your mouse. 

 

Please Note: If you want to create a new 

point AND move it, make sure you a) left 

click to create the point b) release the left 

button, c) click on the left button and 

hold it down to drag the point. 

 

 To Delete a point:  

When the mouse gets near a  

drag handle (point), the black drag 

handle turns into a small empty black 

square. 

Then, either click your Right Mouse to 

show the options menu  

choose Delete Point, or press the Del key 

on your keyboard 
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Use this tool to draw an exclusion hole in 

your polygon. 

Click on the button to put your mouse 

into “polygon hole mode”. 

Now click inside the polygon and using 

the same polygon drawing steps as above, 

draw the hole. Click Right Mouse button 

to close it. 

 

 
Undo Button – Undo your drawing actions  

 

To undo your drawing actions, one by one, either click on this button 

or press Ctrl+Z on your keyboard. 

Each of your drawing actions will be undone in order.   

 

 
Panning Tool   

Use this button to turn off the drawing modes. By default in PDP,  

holding down your left mouse puts it into panning mode, so there is 

no need to click on this button except to revert your mouse behaviour 

back to its default.  

  

 
Selection Tool   

 

Use this button to turn on Selection Mode. Click inside a polygon to 

select it. Then either click your Right Mouse 

button for options. To delete the polygon you can 

press the Del key on our keyboard.  

Advanced Image Processing  

 
Button to commence drawing a hole 
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The Advanced 

Image Analyzer (“AIA”) is a powerful tool for applying calculations to 

the data which underlies images. 

 

To operate on an image, have that image selected in the “Precision 

Data Desktop”, then click on the “Use Image” button. 

 

AIA –Example #1 

 

To create a Nitrogen replacement image from a yield image, where that  

crop removes 20Kg/Ha of N, use the formula 

1. Use Image 

2. Click on the * button (Multiply) 

3. Enter 20 (by clicking on the numbers on the calculator) 

4. Click “=” 

 

The resulting image will show the replacement N required in Kg/Ha 
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AIA –Example #2 

Turn a map of yield values into the square root of those values.  

 

Step 1 – I click on the “All Precision Images” button to list previously 

created images 

Step 2 – I select an image (a yield map) ... 

 

Step 3 – Click on the AIA button  

 

 

 

Step 4 – Click on the “Use Image” button  

Step 5 – Click on the “Sqrt” button – the result below (Yield Map of the 

Square Root of the Yield)... 
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AIA – Other options explained 

For the example above we used the Square Root button   

The same process is used for any of these buttons... 

 

Clicking on any of these buttons will instantly update 

the image and the histogram. 

 

Tip: Hover your mouse over any button for hints. 
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  This button enables you to increase the values of the data 

behind an image by “the power of” a user specified amount. 

Steps 

1. Having selected an image, click on this button 

2. Using the numeric buttons, enter your “Y” value. 

3. Click on the “=” button 

 

 

This button enables you to remove values from the data 

behind an image which are greater than a value of your 

choosing. 

Steps 

1. Having selected an image, click on this button 

2. Using the numeric buttons, enter your threshold or limiting 

value. 

3. Click on the “=” button 

 

This button enables you to remove values from the data 

behind an image which are less than a value of your 

choosing. 

Steps 

1. Having selected an image, click on this button 

2. Using the numeric buttons, enter your threshold or limiting 

value. 

3. Click on the “=” button 

 

 

Using this button you can derive an image that is made up of 

the smallest values behind each pixel in 2 or more images. 

For example, if you have 2 images of wheat yield for a paddock, you 

can derive an image of the worst yield for each pixel by following these 

steps.  

Note: You will need both of the images loaded and displayable on the 

Precision Data Desktop (“PDD”) 

Steps 

1. Having selected an image, click on this button 

2. Now choose the other of the two images (by simply clicking on 

the image name in the PDD list) 

3. Click on the “=” button 
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Using this button you can derive an image that is made up 

of the largest values behind each pixel in 2 or more images. 

For example, if you have 2 images of wheat yield for a paddock, you 

can derive an image of the best yield for each pixel by following these 

steps.  

Note: You will need both of the images loaded and displayable on the 

Precision Data Desktop (“PDD”) 

Steps 

1. Having selected an image, click on this button 

2. Now choose the other of the two images (by simply clicking on 

the image name in the PDD list) 

3. Click on the “=” button 

 

 

Use this button to assign the currently displayed palette to 

the selected image. 

 

 

 

 

Linear -v- Equalized Images 

Let’s say you’ve got some yield data that contains 30,654 

values between 0 T/Ha and 1.5 T/Ha. Over an area of 80 

Ha. (approximately). 

Over 80% of the values lie in the range 0.45 T/Ha to 0.97 T/Ha with 

the remaining 20% being less that 0.45 T/Ha or more than 0.97 T/Ha. 

  

When you first generate an image, PDP uses the Linear method. It 

apportions each of the chosen colours (in my case 8) an equal data 

range (in my case 0.18 T/Ha) based on the number of data intervals 

(8) between 0 T/Ha and 1.5 T/Ha.    
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Using Linear, 80% of our data is in the 0.45 - 0.97 T/Ha range, so the 

image will be dominated by the colours you have chosen for this part 

of the overall data range.  

 

When you click on the “Equalize” button, PDP will rearrange the 

histogram so that each colour in your chosen colour range is 

represented by an equal area on the image. By doing so, your image 

will amplify the variability across the area of the data.  

   

Here is the result of clicking on the Equalize button. Each of the eight 

colours in my initial set of colours is used and each colour is used to 

represent an equal area on the image. In this case 10 ha.  

The large blue section on the top of the histogram represents all data 

values between 0.89 and 1.5 T/Ha. (10.1 Ha) 

The next colour (darker blue) represents all the data values between 

0.84 and 0.89 T/Ha (10 Ha).   

The next colour (dark green) represents all the data values between 

0.80 and 0.84 T/Ha (10 Ha).   
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And so on ...  

 

 

Please note: the configured data range colour grid relates to the Linear 
view of the image only.   
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Processing Data Over Years - Aggregate 
Functions 

PDP will create an image of the years of data chosen and based on 

your selection it will 

Maximum Data Value  

- find the maximum value at each pixel of the image and use that 

value to colour the pixel. 

Minimum Data Value  

- find the minimum value at each pixel of the image and use that 

value to colour the pixel. 

Average Data Value  

- calculate the average value at each pixel of the image and use 

that value to colour the pixel. 

 

To access these features, Right Click your mouse on the Dataset Layer 

in your Precision Data Desktop. See Page 12.  
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Tips for Importing Yield Data  

 

 

ILF Files – Select the folder (or 

Card Reader Drive) that 

contains the ILF files (do not 

select a file)   
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 Caterpillar Claas CHN Files – 

Select the folder Auftrag that 

contains the AFT files (do not 

select a file)  

 

 Agleader Case YLD Files – 

Select the folder (or Card 

Reader Drive) that contains the 

YLD files (do not select a file)  

 

 Case New Holland, Agleader 

CHN Files – Select the folder (or 

Card Reader Drive) that 

contains the Combines, Farms, 

Log Folders & the Index.vyg or 

index.vy1 (do not select a file)  

 

 John Deere Apex Export CSV 

Files – Select the folder (or Card 

Reader Drive) that contains the 

CSV files (do not select a file)  

 

 John Deere GSD Files – Select 

the folder (or Card Reader Drive) 

that contains the GSD files (do not 

select a file) Only Numbers show 

for Farms & Paddocks 
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 GSY Files – Make sure they are in 

a PFDATA folder below the folder 

you select. If not you will get the 

error message “No Files were 

Found” Select the folder above the 

PFDATA folder when importing. 

 

 If only GSY Files are available No 

Farm or Paddock names come up 

only Numbers that are stored in 

the monitor. This makes it difficult 

to match with PAM. 

 

 

 

 

 

 

 

 

 

If the full list of folders are there 

the Farm and paddock name 

show. 

 

 Greenstar 2 Files – Select the 

folder (or Card Reader Drive) that 

contains the EIC, Fonts Programs, 

RCD Folders  (do not select a 

folder or file below that)  
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A 

abandon the image you created, 23 

Agleader Case YLD Files, 59 

All Precision Data Sets, 10 

Apex Export CSV Files, 59 

Applicant - VRT, 41 

Auto-Fit to Data, 21 

C 

Case New Holland, 59 

Caterpillar, 59 

Change Accuracy, 42 

CHN Files, 59 

Cicles Tab, 17 

Circle Colour, 17 

Circle Size, 17 

Circles, 45 

Claas, 59 

comma delimited, 7 

constraint polygon, 29 

Contouring Toolbar, 18 

Coordinate Systems, 43 

custom palettes, 45 

D 

Data Matching, 9 

Data Set Tools Toolbar, 18 

Data Statistics, 31 

Data Subset tool, 19 

Datum, 43 

Default Fallback rate  - VRT, 42 

Discard points, 31 

Display Data Statistics, 19 

drawing a hole in your drawn polygon, 19, 50 

drawing a polygon, 19, 48 

drawing mode, 48 

F 

Fallback rate, 41 

FARMSTAR 

Circles, 27 

Fields, in FarmStar terms, 44 

File Requirements, 7 

G 

Getting your data from a card, 21 

Getting your data into PDP, 7 

Global Positioning System, 43 

GPS, 43 

Greenstar 2 Files, 60 

GSY Files, 60 

I 

ILF Files, 59 

Image Constraint Polygon, 29 

Images, 45 

Imaging, 14 

Imaging Tips and Options, 23 

Import File Tips, 10 

J 

John Deere GSD Files, 60 

K 

Kriging, 14 

L 

Linear, 56 

M 

Mapping Terms, 5 

Merging two data sets, 33 

Column Matching, 35 
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N 

Number of Intervals, 22 

P 

palettes, 45 

panning or dragging tool, 19 

Pixel size, 15 

Precision Data Desktop, 12 

Precision Farming Tools, 2 

Print, 12 

Projection, 43 

R 

Rate Change Accuracy – VRT, 42 

Remove, 13 

S 

save the image file, 22 

Solid or, 22 

Step value, 22 

Steps to create a yield image, 21 

Steps to import your yield data, 21 

Subset Data, 30 

T 

Transparency slider, 18 

U 

Units - VRT, 42 

Unload Existing, 13 

V 

Variable Rate Control, 36 

very high values, 23 

Visualising your Data, 44 

VRT - Rate Change Accuracy, 42 

VRT Control file, 42 

Z 

Zoom To Layer, 13 

 


